Bond Prerequisites

last updated 9/19/2003

Disclaimer
The material in this information packet is for educational purposes only and not to be construed as legal advice about what you should or should not do.  The information herein is to assist you in performing your own due diligence before implementing any strategy.  By using this material, you are agreeing that no particular result is guaranteed or implied.
Some conventions used in this document:

Throughout this file, you will see information presented in two different fonts and colors.  Instruction pages will use the Arial (san serif/without curves) font and navy blue as the color (this page uses this font and color).  The information on the instruction pages will be educational in nature and, most of the time, will contain instructions to follow or tasks to perform. 

Instructions will generally not be mixed with the document pages; but, if it is necessary to mix them, the font and text color conventions will be followed.  So, if there are instructions imbedded in a document page or highlighted text, you will need to delete the instructions and remove the highlighting before printing the final version of the document page.

Document (contacts, affidavits, etc.) pages use Times Roman (serif/with curves) font and in black ink.  You will customize the document pages and then do something with them, such as mail or record them.  

Please “Print Preview” your documents before you print them.  This is especially important if you have substantial personal information you have added to a document, such as many other names.  Also, some printers will not let you print closer to the margin than .55 inches.  Feel free to adjust the margins if your printer will not accommodate the current spacing. 

Food for Thought

The bond (insurance policy) is that US currency is legal tender.
Money of account is legal tender.
Money of substance is silver and gold.
Lawful and legal are not the same.
Lawful money of substance in not US currency.
Lawful money of substance has to be an asset - not a debt.
The Bond Process

The purpose of this file is to create a set of documents to aid you in the copyright process.  This process will aid you in taking back control of your straw man by giving you ownership of the words in your name.  This process is currently broken down into a number of sub-steps.  Within this file, the beginning of each step will start with instructions and/or educational material for that sub-step.  The sub-step will be identified with large bold red text.

a. Replace tags with your data

The copyright documents contain a number of variables (called “tags”) that act as place holders for your personal data.  The table below shows a list of all of these tags.  The first column explains what the data should be; the second is the strings that will be replaced (the tag).  You will be replacing all of the tags for the entire redemption process as you follow the steps below.  The last column is a sample of what the data might look like in place of the tag.  

Before you begin your customizing work, save a copy of this file now under a different file name.  Use the “Save as” option under the “File” menu; i.e., you might insert your last name and the date when the file was created somewhere in the file name, e.g. Smith-Bond-2003-07-21.doc.

You will use the “Replace” facility in MS Word to search for and replace each of the strings in the “Replacement String” column shown below.  The “Replace” menu item can be found under the “Edit” menu.  When you select “Replace” a dialog box will open that contains a line labeled “Find what:” where you will enter the string you want to replace.  The dialog box also contains a “Replace with:” line where you will enter the correct data. 

For example, if you want to replace the “<551663983>” tag, you would enter “<551663983>” in the “Find what:” line and type your 551663983 on the “Replace with:” line.  Then, you would click the “Replace All” button.  Repeat this process for each tag in the list.

To make sure that you have not missed any tags, scroll to the top of this file and perform a search operation for “<”.  The “Find” menu item is under the “Edit” menu.  If you aren’t able to locate any tags, then you have successfully replaced all tags.

Once this is done, save the file again under the new name to make sure you don’t lose all your work.

	Description
	Replacement string
	Sample data

	True Name - your current full legal name with upper & lower case letters
	Linda Marie Egbert
	John Quincy Public

	Your straw man name which is your full name in all capital letters
	LINDA MARIE EGBERT
	JOHN QUINCY PUBLIC

	Your first name in upper & lower case
	Linda
	John 

	Your last name in upper & lower case
	Egbert
	Public

	Your mail address (make sure it includes the state where you reside)
	c/o17067 Avon Way
Madera, California state

[93638]
	100 Maple Ave.

Irving, Texas [76133]

	City where you reside
	Madera
	Irving

	Your gender, “man” or “woman”
	woman
	man

	County where you get your documents notarized
	Madera
	Dallas


b. Notice of Competency (recordable)
The Notice of Competency is a very serious document.  It states that you are competent to handle all of your affairs.  That means, should you have to go to court, you would have to represent yourself and be competent.  Therefore, you could appear in court as either propria persona or sui juris.  Further, each of the agencies listed must be individually notified of the recordation of this document by serving them a copy of the recorded document:  This is a very forceful document and a step that you should strongly consider the ramifications of before executing and recording.

This document says you are the “surety”, the “principal” for the straw man, so be sure to read and understand the meanings of these terms in your law dictionary.

Your seal on this document is your thumb print (preferably from a red-ink stamp pad or blue or purple) with your initials half-way in the thumb print and half-way out.

The Notice of Competency has been prepared in two formats. Both versions are in affidavit form.  The version that begins on the next page is suitable for recording with the county recorder.  Should you decide to utilize this document, print at least two copies of the document.  Take all the copies to a notary and sign them in front of the notary.  One of these copies can be used to record with the county recorder for your county.

When the county recorder sends you the original version back, keep it for your files.  Never send this original to anyone.  You may have additional certified copies made if you need to forward a certified copy to someone.

When Recorded, Mail to:

Linda Egbert
without prejudice

c/o 17067 Avon Way
Madera, California state [93638]
a temporary mailing location

Verified Declaration in the Nature of an Affidavit for Truth in Commerce and Contract by Waiver for Tort Presented by me, Linda Marie Egbert, living soul, one for We the People under Original Common Law Jurisdiction by the California and united States of America Contracts, the Constitution

California State Republic,  one
)

of  the several united States
) ss.
DECLARATION BY AFFIDAVIT
in America
) 
NOTICE OF COMPETENCY AND INCOMPETENCE 
WITH FIRING AND DEMAND TO CEASE AND DESIST
Linda Marie Egbert
without prejudice

c/o 17067 Avon Way
Madera, California state [93638] 
Equality under the law is PARAMOUNT and MANDATORY.  I am competent to handle my affairs.  A sovereign cannot be tried in his/her court.

I am accepting all documented matters as recorded by the below listed, for the past, present and future with the person named LINDA MARIE EGBERT or any other derivatives and everything stated as true.  I am returning all documented recorded past, present and future matters to you for discharge and closure.

Agents of the UNITED NATIONS et al.,

Agents of the UNITED STATES et al., and/or the United States of America

Agents of the TREASURY OF THE UNITED STATES et al.,

Agents of the FEDERAL RESERVE et al.,

Agents of the BUREAU OF ALCOHOL, TOBACCO AND FIREARMS et al.,

Agents of the INTERNAL REVENUE SERVICE et al.,

Agents of the FEDERAL BUREAU OF INVESTIGATION et al.,

Agents of the UNITED STATES POSTAL SERVICE et al.,

Agents of the FEDERAL BUREAU OF PRISONS et al.,

Agents of the STATE OF CALIFORNIA et al.,

Agents acting as any COUNTY CORPORATE GOVERNMENTS et al.,

Agents acting as any MUNICIPALITY CORPORATE GOVERNMENTS et al.,

I hereby declare the above so named as Incompetent and I presently and permanently revoke their power of attorney for representing me making a legal determination for me in any of my affairs.  Return the vouchers to me immediately.

It is hereby Demanded and ordered by the Sovereign, Linda Marie Egbert, that all parties Cease and Desist all future actions, and those trespassing on my land and property without specific permission from the people’s Certified Republic Government are demanded to leave this Land or be subject to the people.

By me, on this ___ day of _______________, 200__ A.D., Linda Marie Egbert, owner, principal surety,

By autograph 

Linda Marie Egbert
seal: 

NOTICE

Using a notary on this document does not constitute any adhesion, nor does it alter my status in any manner.  The purpose for notary is verification and identification only and not for entrance into any foreign jurisdiction.

California state Republic
)


) ss.
JURAT
Madera County
)

On the ___ day of ________, 200__, <true-name> personally appeared before me and proved to me on the basis of satisfactory evidence to be the person whose name is subscribed hereto and acknowledged to me that he/she executed the same under asseveration, and accepts the facts thereof.  Subscribed and affirmed before me this day.  Witness my hand and seal this ____ day of __________, 200__.


Stamp

Notary Signature

c. Notice of Competency (affidavit format)
The Notice of Competency that begins on the next page is in affidavit format.  This copy is suitable to mail to anyone to whom you need to mail a copy to give them notice of your competence.  Should you decide to utilize this document, print at least two copies of the document.  Take all the copies to a notary and sign them in front of the notary.

At all times, keep at least one original Notice of Competency in your files.  You can use this original to make further copies if needed. 
California State Republic,  one
)

of  the several united States
) ss.
DECLARATION BY AFFIDAVIT
in America
)
Verified Declaration in the Nature of an Affidavit for Truth in Commerce and Contract by Waiver for Tort Presented by me, Linda Marie Egbert, living soul, one for We the People under Original Common Law Jurisdiction by the California and united States of America Contracts, the Constitutions1.

NOTICE OF COMPETENCY AND INCOMPETENCE 
WITH FIRING AND DEMAND TO CEASE AND DESIST

Linda Marie Egbert
without prejudice

c/o 17067 Avon Way
Madera, California state [93638]

Equality under the law is PARAMOUNT and MANDATORY.  I am competent to handle my affairs.  A sovereign cannot be tried in his/her court.

I am accepting all documented matters as recorded by the below listed, for the past, present and future with the person named LINDA MARIE EGBERT ©  or any other derivatives and everything stated as true.  I am returning all documented recorded past, present and future matters to you for discharge and closure.

Agents of the UNITED NATIONS et al.,

Agents of the UNITED STATES et al., and/or the United States of America

Agents of the TREASURY OF THE UNITED STATES et al.,

Agents of the FEDERAL RESERVE et al.,

Agents of the BUREAU OF ALCOHOL, TOBACCO AND FIREARMS et al.,

Agents of the INTERNAL REVENUE SERVICE et al.,

Agents of the FEDERAL BUREAU OF INVESTIGATION et al.,

Agents of the UNITED STATES POSTAL SERVICE et al.,

Agents of the FEDERAL BUREAU OF PRISONS et al.,

Agents of the STATE OF CALIFORNIA et al.,

Agents acting as any COUNTY CORPORATE GOVERNMENTS et al.,

Agents acting as any MUNICIPALITY CORPORATE GOVERNMENTS et al.,

I hereby declare the above so named as Incompetent and I presently and permanently revoke their power of attorney for representing me making a legal determination for me in any of my affairs.  Return the vouchers to me immediately.

It is hereby Demanded and ordered by the Sovereign, Linda Marie Egbert, that all parties Cease and Desist all future actions, and those trespassing on my land and property without specific permission from the people’s Certified Republic Government are demanded to leave this Land or be subject to the people.

By me, this ___ day of _______________, 200__ A.D.,  Linda Marie Egbert,  owner, principal, surety,

By autograph 



<true-name>

seal: 

NOTICE

Using a notary on this document does not constitute any adhesion, nor does it alter my status in any manner.  The purpose for notary is verification and identification only and not for entrance into any foreign jurisdiction.

California state Republic
)


) ss.
JURAT
Madera County
)

On the ___ day of ________, 200__, Linda Marie Egbert personally appeared before me and proved to me on the basis of satisfactory evidence to be the person whose name is subscribed hereto and acknowledged to me that he/she executed the same under asseveration, and accepts the facts thereof.  Subscribed and affirmed before me this day.  Witness my hand and seal this ____ day of __________, 200__.


Stamp

Notary Signature

d. Affidavit in Support of Bond
The Affidavit in Support of Bond is a document that is in recordable affidavit format.  This affidavit is your statement stating why you have the ability to issue a bond.  You will now perform some additional customization of the Affidavit in Support of Bond.

Yellow highlighting indicates you must customize specific text within a document before printing.  The affidavit contains yellow highlighted text which says, “insert all spelling variations of your name.”  Replace the highlighted text with all the variations of your name.

If you are a woman, you may wish to include all the variations of your maiden name and your married name.  If you have been married multiple times, you may wish to include those as well.  It may only be necessary to include your prior married names if you are concerned that they may still be in use currently.

Below is a list of the variations of a sample name, John Quincy Public, to give you an idea of what variations you should include.

JOHN QUINCY PUBLIC
john quincy public

JOHN Q. PUBLIC
John Q. Public

JOHN Q PUBLIC
John Q Public

JOHN PUBLIC
John Public

J. Q. PUBLIC
J. Q. Public

J Q PUBLIC
J Q Public

PUBLIC, JOHN QUINCY
Public, John Quincy

PUBLIC, JOHN Q.
Public, John Q.

PUBLIC, JOHN Q
Public, John Q

Notice that the list does not include the true name, i.e. John Quincy Public.  This is because your true name can’t be trademarked.  Don’t worry about trying to get every conceivable variation that might be used because the documents say “including any and all derivations and variations in the spelling”.

Print out a copy of the document.  Take it to a notary and sign it in front of the notary.  Then take the notarized document to the county recorder to have it recorded. This can be done at the same time you record the Notice of Comptency.

When the county recorder sends you the original version back, keep it for your files.  Never send this original to anyone.  If you need additional copies for any reason, obtain Certified Copies and only send out the Certified Copies.

When Recorded Mail to:

Linda Egbert
c/o  17067 Avon Way
Madera, California state [93638]

a temporary mailing location

Verified Declaration in the Nature by an Affidavit for Truth in Commerce and Contract by Waiver 
for Tort Presented by me, Linda Marie Egbert, living soul, one for We the People under Original Common 
Law Jurisdiction by the <res-state> and united States of America Contracts, the Constitutions1.

Republic and one by the
)

several united States
)   ss.
DECLARATION BY AFFIDAVIT
California
)
in Support of the

in America
)
BOND TO DISCHARGE DEBT

Notice for the agent is notice for the principal applies under this notice.

Notice for the county clerk for the county Madera, California and
record court for original jurisdiction, is notice for all.
For: Whom it may concern: In the Matter for Linda Marie Egbert, Egbert Linda Marie, Linda Egbert, Egbert Linda M. ., Linda M. Egbert (including any and all derivatives thereof), hereinafter LINDA MARIE EGBERT ©.
I, Linda Marie Egbert, , hereinafter “Secured Party”, the undersigned for one We the People, natural born living souls, the Posterity, born upon the land in the one for several counties within the one for the several  States united for America, the undersigned Posterity, Creditors, Claimants and Secured Party, hereinafter “I, Secured Party”, do hereby solemnly declare, say and state:

1. I, the Agent, am competent for stating the matters set forth herewith.

2. I, the Agent, have personal knowledge concerning the facts stated herein.

3. All the facts stated herein are true, correct, complete, and certain, not misleading, admissible as evidence, and if stating I, the Secured Party shall so state.

Plain Statement of Facts

A matter must be expressed for being resolved. In commerce, truth is sovereign.
 Truth is expressed in the form for an Affidavit.

An Affidavit not rebutted stands as Truth in commerce. An Affidavit not rebutted, 
after thirty (30) days, becomes the judgment in commerce. A Truth Affidavit,
under commercial law, can only be satisfied: by Truth Affidavit rebuttal, by 
payment, by agreement, by resolution, or by Common Law Rules by a jury.
I, the Secured Party, am expressing truth by this Verified Declaration in the Nature for an Affidavit of Truth in Commerce and Contract by Waiver for Tort Presented by me, Linda Marie Egbert, living soul, the Secured Party, one for/under We the People under Original Common Law Jurisdiction for the California and united States of America Contracts, the Constitutions.

WHEREAS, the public record is the highest evidence form, I, Me, My, Myself, the Secured Party, am hereby timely creating public record by Declaration with this Verified Declaration in the Nature for a Truth Affidavit in Commerce and Contract for a Tort Waiver Presented by Me, Linda Marie Egbert, living soul, the Secured Party, one for/under We the People under Original Common Law Jurisdiction for the California and united States of America Contracts, the Constitutions, to wit:

1. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, after 1938, the supreme law of the land in the U.S. is anything other than “Public Policy” concerning commercial transactions made under the "Negotiable Instrument Law" as a result of the U.S. Bankruptcy as declared by President Roosevelt on March 9, 1933 and codified at 12 U.S.C.A. 95a and by Executive Orders, and in accord with HJR 192 of June 5, 1933, and believe that none exists;

2. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, the Negotiable Instruments Law is anything other than a branch of the "International Law Merchant," which is now known as the "Uniform Commercial Code," (UCC) that was 'drafted' and made uniform, and "adopted in whole or substantially by all states." Black's Law Dictionary, Sixth Edition - page 1531. Thus the several states were and are bound into commercial agreements to the federal United States under the Uniform Commercial Code, and believe that none exists;

3. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, the Secretary of the Treasury in Puerto Rico is anything other than the Trustee of the U.S. Bankruptcy as declared by President Roosevelt on March 9, 1933 and codified at 12 U.S.C.A. 95a and by Executive Orders, and believe that none exists;

4. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, the people inhabiting the several states of the united States of America are anything other than the Creditors of the U.S. Bankruptcy as declared by President Roosevelt on March 9, 1933 and codified at 12 U.S.C.A. 95a and by Executive Orders, and in accord with HJR 192 of June 5, 1933, and believe that none exists;

5. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, “discharges of debts”, “dollar for dollar” by the Creditors via the Trustee of the U.S. bankruptcy are anything other than lawful “tenders of payment” pursuant to the “Public Policy” established when lawful money was removed from circulation as a result the U.S. Bankruptcy as declared by President Roosevelt on March 9, 1933 and codified at 12 U.S.C.A. 95a and by Executive Orders, and in accord with HJR 192 of June 5, 1933, and believe that none exists;

6. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, a refusal of a tender of payment by way of a “discharge” of a debt is anything other than a “discharge” of the debt pursuant to UCC 3-603 as enacted in associated state statutes, and believe that none exists;

7. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that a “Bond to Discharge Debt” is anything other than a negotiable instrument as defined in section 3 of the UCC, and believe that none exists;

8. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, a refusal of a tender of payment of a debt by way of a “Bond to Discharge Debt” is anything other than a “discharge” of the debt pursuant to UCC 3-603 as enacted in associated state statutes, and believe that none exists;

9. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, a “Bond to Discharge Debt” is anything other than a “discharge” of the National Debt and beneficial to the national economy, and believe that none exists;

10. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, a “Bond to Discharge Debt” is anything other than a good faith attempt to discharge the debt and to settle and close the account, and believe that none exists;

11. Fact: I, the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, the use of Executive Order 11825 as a Letter of Credit is anything other than adequate assurance of the consideration exchanged and the unlimited line of credit provided to the American people when the U.S. took the gold and property of the American people in 1933 as collateral as a result of the U.S. Bankruptcy as declared by President Roosevelt on March 9, 1933 and codified at 12 U.S.C.A. 95a. and by Executive Orders, and believe that none exists;

12. Fact: I the Secured Party, have not seen or been presented with any admissible evidence which demonstrates that, primarily, the “Bond to Discharge Debt” is anything other than the main remedy provided by the Creator in Isaiah 52.3 to enable His People to be released from bondage and to serve Him in these end times as His special “holy nation” in direct fulfillment of the type and example provided by the Israelites when they were freed from Egypt, and believe that none exists.

I, the Secured Party, am not an expert in the Law; however, I do know right from wrong.  If there is any living soul that is being unjustly damaged by any statements herein, if he/she will inform Me by facts, I will sincerely make every effort to amend My ways.

I, the Secured Party, hereby and herein reserve the right for amending and making amendments to this document as necessary in order that the truth may be ascertained and its proceeding justly determined.

If any living soul has information that will controvert and overcome this Declaration, since this is a commercial matter, please advise Me IN WRITING by DECLARATION/AFFIDAVIT FORM within ten (10) days from recording hereof, providing Me with your counter Declaration/Affidavit, proving with particularity by stating all requisite actual evidentiary fact and all requisite actual law, and not merely the ultimate facts and law conclusions, that this Affidavit by Declaration is substantially and materially false sufficiently for changing materially My or My LINDA MARIE EGBERT’s status and factual declaration.

Your silence stands as consent, and tacit approval, for the factual declarations here being established as fact as a law matter and this affidavit by Declaration will stand as final judgment in this matter. 

The Undersigned, I, the Secured Party, holder in due course for original, do herewith declare, state and say that I, Secured Party, issue this with sincere intent in truth, that I, the undersigned Secured Party, am competent by stating the matters set forth herein, that the contents are true, correct, complete, and certain, admissible as evidence, reasonable, not misleading, and by My best knowledge, by Me, the undersigned.

By me, this ___ day of _______________, 200__ A.D., Linda Marie Egbert, owner, principal, surety,

By autograph _____________________________________

Linda Marie Egbert
c/o 17067 Avon Way
Madera, California state [93638]
NOTICE

Using a notary on this document does not constitute any adhesion, nor does it alter my status in any manner.  The purpose for notary is verification and identification only and not for entrance into any foreign jurisdiction.

California state Republic
)


) ss.
JURAT
Madera County
)
On the ___ day of ________, 2007, Linda Marie Egbert  personally appeared before me and proved to me on the basis of satisfactory evidence to be the person whose name is subscribed hereto and acknowledged to me that he/she executed the same under asseveration, and accepts the facts thereof.  Subscribed and affirmed before me this day.  Witness my hand and seal this ____ day of __________, 2007.
Stamp



Notary Signature


� Use of state and federal statutes within this document is only to notice the reader that which is applicable to them and is not intended, nor shall it be construed, to mean that the Secured Party confers, submits to, or has entered into any jurisdiction alluded to thereby.


1 Use of state and federal statutes within this document is only to notice the reader that which is applicable to them and is not intended, nor shall it be construed, to mean that the Secured Party confers, submits to, or has entered into any jurisdiction alluded to thereby.


1 Use of state and federal statutes within this document is only to notice the reader that which is applicable to them and is not intended, nor shall it be construed, to mean that the Secured Party confers, submits to, or has entered into any jurisdiction alluded to thereby.






